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Contact and Support Information
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Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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Information in Tax Release Notes
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CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

& (Contact and Support information

B Updates to Tax technology (such as, electronic filing updates, Organizer, Pro Forma/roll
forward, and technology enhancements)

® Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2017-3.4
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Common Updates

2-Step Verification (a.k.a. Multi-Factor Authentication)

With the 2017-3.4 release, 2-Step Verification will be available as an optional setting for firm
Administrators to configure in Firm > Settings and Defaults > Login Setup. 2-Step Verification applies to the
CCH Axcess login mode and not the Active Directory or Federated Services login mode.

Why is 2-Step Verification important?

Tax refund fraud in 2016 reached about $21 billion, up from just $6.5 billion in 2014, according to the IRS.
With recent rises in tax-related identity theft and phishing attacks, thieves can gain access to confidential
staff and client information. Even complex passwords that require a combination of letters, numbers, and
special characters may not be enough to protect sensitive data.

A password is a single factor in the log in authentication process to verify identity. 2-Step Verification
requires a second factor in addition to the password as part of the authentication process. This requirement
adds another layer of protection against hacking and fraud attempts. With 2-Step Verification, if a criminal
hacks your password layer, your CCH Axcess account cannot be accessed without your phone number or
email address.

How is 2-Step Verification Enabled for a Firm?

Wolters Kluwer maintains a strict security protocol and encourages firms to do the same by enabling 2-Step
Verification as an added layer of protection.

When enabled, staff will experience the following 2-Step Verification authentication processes:

® Every time, if the user does not select Remember this device when logging in
® When logging in from a new device or from a new web browser on a registered/trusted device

® When logging in more than 30, 60, 90, or 120 days after the last verification, depending on the
firm configuration setting

Notes:

& 2-Step Verification is not currently applicable to firms configured to authenticate via Active
Directory Integration (ADI) or Active Directory Federated Services (ADFS).

B ?2-Step Verification may be enabled or disabled at the firm level only and not on a user-by-user
basis.

B CCH Axcess does not currently support any third-party Multi-Factor Authentication applications.

For more information, see our article and video on administrators enabling 2-Step Verification for your firm.
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Important Note: With the initial release of 2-Step Verification in CCH Axcess, the default is a
disabled state and the firm must opt-in to enable the option. Based on increased security requests by
the various taxing jurisdictions, we will change the option default to be enabled and the firm must
opt-out to disable the feature. This change will occur on the 2017-5.0 release in November, 2018.

Important Notes for Portal Customers:

® 2-Step Verification is already an available optional setting in CCH Axcess Portal and CCH Client
Axcess, and is configured separately from CCH Axcess. Beginning with the 2017-3.4 release on
4/29/18, 2-Step Verification for Portal will be enabled automatically for all Portal accounts.

B Due to the web-based nature of CCH Axcess Portal, firms will not be able to opt-out of 2-Step
Verification for Portal.

B For firms licensed for the standalone version of Portal, all users logging into the Silverlight or
Client Axcess interfaces will be required to use 2-Step Verification as described above.

® For firms licensed for the integrated version of Portal, firm users cannot log into the website,
so Portal's 2-Step Verification settings will not apply to those firm users.

Dashboard Notes

& (Client and contact notes. The new Client and Contact Notes Assigned to Me pane in your
Dashboard lists a summary of client and contact notes that may require your attention. Add this
pane to your Dashboard to manage due dates, assigned staff, and completion states. Adding and
editing notes has the same experience as previously released for Client Dashboard.

® Tax return and Workstream project notes. The Dashboard pane listing tax return or project
notes that are assigned to you is renamed Return and Project Notes. The content and functions
of the pane are unchanged.

Note: Refer to Dashboard Help for details about configuring the layout and content of your
Dashboard.

Tax Updates

Issues Resolved

B We have resolved the issue with calculating certain returns after a batch ELF extension.
Passthrough recaps now sort alphabetically.

You can now successfully print and download all copy types for large returns in Batch Manager.
Certain consolidated statements print now total correctly.

Alabama Specialized extensions now process correctly when run for the second time through
Batch Manager, and when trying to file other quarter estimates after filing the first quarter
estimate.

® When printing diagnostics, you now only receive print for the selected tab.
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Tax Product Updates

Individual (1040) Product Updates
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Federal

Cover Letter. The form attachment paragraph will only issue when the state or city is not being
electronically filed.

Form 1040NR.

® Diagnostic 40328 issues when Lines 23, 36, 42, 52, 61, and 71 are all equal to $0, unless Form
8582 is present in the return.

B Diagnostic 47243 issues when withholding is greater than the sum of wages, taxable interest,
ordinary dividends, scholarship or fellowship grants, IRA distributions, pensions, unemployment
compensation, other income, total income exempt by treaty, gross receipts on Schedule C, and
total income from Form 1040NR, Schedule NEC, except when Form 4797 or Schedule D or E is
also present in the return.

Form 1040NR. In situations where the return qualifies for Form 1040NR-EZ, but that form was not requested,
statements will conditionally print Form 1040NR or Form 1040NR-EZ in the upper-left corner, depending on
which form is used in the return.

Form 6251. When an activity is coded as subject to recharacterization, there is an overall gain for both
regular tax and AMT, and an adjustment for the sale of an asset, the adjustment is included on Form 6251,
Line 17.

Form 8962. If Form 1040NR is being prepared and the option to transfer the Form 1040 information to Form
1040NR is selected, the number of exemptions claimed on Form 1040NR is reported on Form 8962, Line 1.

Form 8965.

® |f a dependent was born during the year, had health insurance coverage for all months after the
month of birth, and everyone else in the household had health insurance coverage for the full
year, Form 1040, Line 61, Full-year coverage, will contain an X.

® |f a dependent, not included on Form 1040, is included on IRS 1095-B or C, Form 1040, Line 61,
Full-year coverage, will contain an X.

1040ES (NR) worksheet. Line 4 and Line 5 calculations have been updated .

Schedule D. When there is current capital gain, a prior year basis 28% capital loss carryover from a
passthrough, and the entity is subject to the basis limitation, the amount reported on Schedule D, Line 12, is
the current year gain minus the allowed 28% capital loss carryover.

Schedule SE. If using the option to autofill FICA and Medicare wages, nothing is input for FICA wages and
withholding on the W-2, and the W-2 has an income code of "Minister - Exempt for SE,"” then "Exempt-Form
4361" will print next to Form 1040, Line 57.

SEP worksheet. The amount of 1/2 of SE showing on the SEP worksheet will reflect the IRS 1099-MISC when
the IRS 1099-MISC was attached to a Schedule C or Schedule F.
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Electronic Filing

Form 114. Alpha characters are not included in the ZIP code for the US address of the filer and account
owner for electronic filing purposes.

Alabama

Per recently enacted legislation, Schedule CR, Line 27, calculates to the lesser of Line 24 or 26.

Arizona Electronic Filing

Form 322, Lines 4 and 9, will now be included in the electronic file

Arkansas
Data entered on Arkansas Income/Deductions > Income > Other income will appear with the default code.

Extensions for filing status 5 returns will not include spouse information.

Idaho
Form 39R.

B Line 18, Health Insurance Premiums worksheet, will only include premiums actually paid by the
Taxpayer or Spouse to Idaho.

B |ines 18 and 19 for Health Insurance Premiums and Long-term Care Insurance are now
conforming to the Federal AGI limitation of 7.5%.

Kentucky

Form 740-X is obsolete for tax year 2017. The Form 740 amended check box now populates when a resident
amended return is requested.

Kentucky Cities
The ZIP code for the OL-3 forms has been updated to 40232-5410.

Louisiana
Forms R-210, R-210NR, and R-210RNA, Line 2, correctly subtracts the prior year nonrefundable and
refundable credits from the prior tax year.

Maryland

Letters will not reflect a due date and will omit the line "No extension is required for Maryland” when there
is a balance due and mailing instruction for extension.

Michigan Electronic Filing

Direct deposit and direct debit are not allowed when electronically filing a Michigan amended tax return.
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New Hampshire

Form NH 1040, Line 6c, will now appear on the New Hampshire Combined Form NH-1120-WE, Line 12c,
when the individual return is present in the New Hampshire 1120, 1120S, or 1065 combined return.

Letters and Filing Instructions will now say "New Hampshire BT-Summary"” if the return is not being filed for
a SMLLC.

North Dakota

Form ND-1, Line 7 bond premiums, will reduce interest based on U.S. Savings Bonds and Treasury
Obligations.

ND-1TC county name(s) will populate when entered.

North Dakota Electronic Filing

Returns, previously including a refund with direct deposit but were changed to apply overpayment to
estimates to be paid electronically, will include the estimate payments in the electronic file and be
submitted to the state for processing.

Oregon
Non-passive losses are included on Schedule OR-PTE-NR for the second PTE record.

The actual column of the Oregon Tax Equalization report includes the Oregon Surplus (Kicker) Credit.

Pennsylvania

Disallowed loss carryovers will not flow to Schedule E, Line 17.

Letters will not indicate the taxpayer should sign and date the REV-276.
Schedule C, Line 4, will include gains from like-kind exchange when requested.

Schedule D, Line 1, will not include gain on sale of home in excess of the $250,000 federal Schedule D
exclusion.

Section 179 carryovers will not flow to Schedule F, Line 16a.

Vermont
EIN is now populating on the HS-122 under the other preparer/firm information section.

VT Form HI-144, Line U, now includes interest and dividend income from taxpayers that are under the age
of 65, as of December 31st, 2017.
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Partnership (1065) Product Updates
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Federal

Form 114, Part V, will print all pages in the Accountant and Client copies when there are more than two
accounts.

Form 8804, Line 5a, calculation has changed for fiscal year filers due to a change in the instructions for this
form published on 4/12/18. See government instructions for further details.

The inclusion portion of guaranteed payments from rental activities is now carried to Schedule M-3 when the
ownership percentage is entered.

The landscape reports now show the section 754 depreciation when the amortization reports are turned on.

California

Schedule K, Line 15a, will reflect the total of Forms 592-B when the option to compute Form 592-B based
on distributions is selected on California > Nonresident Withholding > Options.

Delaware

Form 8821DE. Authorization to Release Tax Information has been added. The input is available on Federal >
Other > 8821 - Tax Info Authorization > General Information.

District of Columbia

Forms D30-NOL. Deduction for Tax Years Prior to 2000 and Deduction for Tax Years 2000 and After can be
produced with input on District of Columbia > District of Columbia (D-30) > Income / Deductions > Net
Operating Loss.

Idaho

Idaho Schedule K-1, Line 14 statement no longer produces when the override input is used.

Idaho Schedule K-1, Line 27, now allows an amount of zero.

Kentucky
The 765/765GP forms will not populate the preparer signature if chosen.

Louisiana

Gains and losses that are coded to a specific state other than Louisiana will not be included on the Louisiana
Schedule D or E.

Louisiana Electronic Filing

Check if also Paid Preparer box on the LA R-8453P will be selected when the option is selected on the ERO
input.

Diagnostic 47995 will not issue for individual partners that have a first and last name or non-individual
partners with an entity name entered.
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New Jersey

Extension Report for NJ-200T will print zero in the "Tax deposited with extension on return” column when
the extension amount is not reported in the NJ return.

Extension Report for NJ-CBT-206 will print zero in the "Tax deposited with extension on return” column
when the extension amount is zero.

Form 1080-C will now print the signing officer's title from the entry on Electronic filing > Paperless E-file >
Signing officer's title.

New York

New York IT-204-CP, Page 8, Line 78, will now show the partner's share of credit code 639 when special
allocation code 34884 is used to specially allocate this credit amount to the partners.

New York IT-635, Schedule E, Part 1 for the month of June, will now show a factor of 0.5 when the hours
worked are less than 150 hours.

New York - New York City

NYC Form 204, Page 2, Line 32, will now calculate the portion of the rent deducted on the federal return,
which is attributable to NYC. If Schedule E, Part 1 is 0, and the amount on Form 1065, Line 13, is all NYC,
then Line 32 will be equal to 1065, Line 13. If the NYC portion of Line 13 cannot be determined, Line 32
will be equal to Schedule E, Part 3, Line 1b, Column a, divided by eight.

North Carolina

Form D-403, Part 4, Line 4, now fills in with "Various" when input is made on Federal > Partners > General
Options > Schedule K-1 Printing Percentages - Printing Purposes Only > Ending, Profit, Option field
(Interview Form K-1, Box 39, code "1".)

Ohio
Forms IT 1140 and IT 4708 investor information schedules will now print the correct suffix entered on

Federal > Partners > Partner Information > Suffix after all investors' last names.

The amended check box on the IT K-1 is now available. Use the federal General > Basic Data > General >
Amended return and Schedule K-1, option 1 to select the box for all IT K-1 recipients. For IT 4708 filers and
IT K-1 recipients, use the federal Common State > State/City Common Data > State code "OHC" and the
Amended Return Override, option 1. For IT 1140 filers and IT K-1 recipients, use the federal Common State
> State/City Common Data > State code "OH" and the Amended Return Override, option 1.

The Form IT 1140, Page 6, check box is now selected for investors included in the filing of the return.

The current depreciation adjustment on the IT K-1 for IT 4708 filers will now show the correct allocated
amount per investor.

Oregon
Work Opportunity Credit entered for Federal will now flow to the OR-65, Schedule I.
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South Carolina

Alternative minimum tax (AMT) amounts will now flow to Form SC [-335B, Line 17, Column A, when both

Federal Schedule K-1, Line 17, and South Carolina > Reduced Tax Rate: 1-335 and 1-335B > Worksheet 2
(Form 1-335B) > AMT ltems are filled.
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Corporation (1120) Product Updates
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Federal

The Totals 4562, Line 7, should not populate when listed property section 179 assets from Line 29 are not
current year assets.

California

Form 3539 will now generate in all circumstances when requested by the preparer.

California Combined

Form 3805Z, Part IV, will now report the amount of assigned credits.

Connecticut

Prior to this release, only assets with 50% bonus depreciation could be included on CT Schedule D, Line 6.
With this release, you may now also include assets with 30%, 40%, and 100% bonus depreciation.

Hawaii
Estimate filing instructions no longer issue for a Hawaii Franchise Tax return when all FP-1 vouchers are 0.
Hawaii contributions carryover / NOL adjustment follows federal 26 CFR 1.170A-11(c)(2) adjustment.

The Signing Officer entry from electronic filing input carries to the N-30 signature area.

[llinois

The EIN override on Federal > Consolidated > State Overrides > General or Interview Form CC-ST-1 is now
used on all Illinois forms in a unitary return to avoid rejection.

lowa Consolidated

Consolidated IA Form 4562A, Column G, Accumulated Federal Depreciation, now calculates the correct
amount from Form 4562A, Column G, from the parent and subsidiary returns.

Louisiana

Diagnostic 17656 will not appear in the return when the Louisiana revenue account number is entered
correctly.

Maine

Form 1120ME with PL 86-272 corporate income tax exemption enabled will no longer accrue any tax.

Massachusetts

Massachusetts has changed instructions to indicate that a prior year overpayment credit should be applied to
the second quarter of the estimated tax calculation, not the first quarter. A prior year overpayment is
considered paid with the due date of the prior year, which is the 15th day of the 4th month. Because this is
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after the 15th day of the 3rd month, the due date of the first installment, it should be applied to the 2nd
quarter. New input has been added to reverse back to the treatment of applying the overpayment to the
first quarter on Federal Payments/Penalties > Estimates and Application of Overpayment (Detail) > State
Estimated Tax Additional Information > Apply Overpayment to first estimate.

Michigan Electronic Filing

Letters for MI linked returns will no longer reference the 8879-SO if the option is selected to print that
signature document.

Nebraska Combined

The total gross sales/receipts for the combined group will no longer appear on the Corporation Filing this
Return line on Nebraska Combined > Schedule Il - Subsidiary or Affiliated Corporations > Column D.

New York City Electronic Filing

Banking information now prints on Form NYC-579-COR when only the main form is being electronically
filed.

When NYC 300 has been suppressed, the NYC 300 signature form no longer generates.

North Dakota

Form 40, Page 3 - Schedule FACT, Line 16, now displays the apportionment factor instead of Line 14 when
the Sales factor weighting election box is selected.

Texas

The extension letter and filing instructions will no longer reference banking information after the banking
information has been removed for Texas.

Texas Electronic Filing

Banking information will now be included in the electronic file when Form 05-163, Texas Franchise Tax No
Tax due Report, is present.

Wisconsin Combined (Included with 2017-3.3)

Form 6, Page 3, Line 30, Recomputed net capital gain applying the loss limitation at the combined group
level, now recalculates the amount present if there is a net loss present for a property type in any unit. If a
loss is not present, the amount on Form 6, Page 4, Line 30, Recomputed Net Capital Gain, applies the loss
limitation at the combined level. This matches the amount on Form 6, Page 3, Line 8, Capital gain net
income.
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S Corporation (1120S) Product Updates
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Federal

Input entered on the Form 5884-A worksheet for California wildfire will now be displayed on the screen
after calculation.

Arizona

The government form instructions link is now available.

Delaware

Form 8821DE. Authorization to Release Tax Information has been added. The input is available on Federal >
Other > 8821 - Tax Information Authorization > General Information.

District of Columbia

The filing instructions for the D-20ES will be produced when the estimate payments are being made by EFT
and the vouchers are not printing.

Indiana
When Form IT-6WTH is suppressed, IT-20S, Line 17, will be 0.

Kansas

Special allocation codes 18603 and 18604 will appropriately allocate amounts to Part 1l of the KS K-1
equivalent.

Kentucky
NOL worksheet input has been added for the credit Form KBI.

The taxpayer name on Form 740NP-WH-EXT will now display the entity name when a continuation name has
been entered.
Louisiana

Form CIFT-620, Line F, will show the correct amount when Schedule H input overrides are used.

Only one third of the Louisiana Citizens Insurance Credit 2014 carryforward amount will be used as a credit
on Form CIFT-620, Page 2, Line 11A.

Maine

Maine special allocation code 21252 has been created and installed in order to provide a means of specially
allocating a shareholder’'s Maine-source deduction items via percentage or units.

Massachusetts

The combined 355U due date has been updated from 3/15 to 4/15 for a calendar year return.
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Minnesota

For non-resident shareholders, either Schedule KS, Line 33 (composite withholding), or Schedule KS, Line 34
(non - resident withholding), now fills on each Schedule KS if a withholding amount is calculated.

For non - resident AWC filers, credits passed through to shareholders by the entity will no longer be
subtracted on Form AWC. The credit amounts now subtract from the amount from Form AWC, Line 6, on
Schedule KS, Line 34.

If nonresident Trust shareholders are marked as Grantor Trusts on the Federal > Shareholders > Shareholder
Information (Detail) > Supplemental Information > If grantor trust field, they now receive a share of Section
179 on Schedule KS, Line 30.

Installment sales input on the Federal > Income / Deductions > 6252 - Installment Sales worksheet that use
federal/state codes that exclude Minnesota will no longer flow to Schedule KS, Line 7a or 7b.

Ohio

Entries on the Ohio > Ohio S Corporation (IT 1140, IT 4708) > Other Composite > Form IT 4708 Shareholder
Information > Produce an Ohio Sch IT K-1 for this investor - override field will now apply to the correct IT
K-1 for the investor listed.

The current depreciation adjustment on the IT K-1 for IT 1140 filers will now show the apportioned amount.

Pennsylvania

Pennsylvania extensions how suppress when using the option to prepare all state and city extensions has
been selected.

Pennsylvania supporting forms and letters now print when the return is coded as a parent of a QSSS.

Rhode Island

RI-1096PT, Line 8c, will include Other Payments entered on the State Tax Payments worksheet.

South Carolina

Form SC1040, Line 18, Amount paid with extension, now accepts zero as valid input entered on
Payments/Penalties > Payments > State Quarterly Payments (Detail) > State S Corporation Composite Tax
Payments > Extension Payments (Interview Form STPAY-2, Box 50).

Form SC4868 will no longer print and the Transmittal Letters and Filing Instructions will be adjusted to
reference the automatic extension granted when the extension for SC1040 is requested but there is no tax
due and a Federal extension is requested/filed.
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Fiduciary (1041) Product Updates
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Federal

Credit from Form 8941 will not be distributed in a final year. As a Section 196 credit, it will become a
deduction. The credit will not appear on the Sch K-1 and as a deduction at the same time.

Form 8903 will distribute amounts in Charitable Lead Trusts.

Schedule K-1 presents AMT capital loss carryovers in a final year when there is no calculation of the
Schedule | or zero is calculated for the distribution deduction for AMT purposes.

The resident state letter will show tax-exempt interest when only tax-exempt interest is distributed for
states that do not start with Federal Adjusted Gross Income.

When the return configuration set is set to suppress the letterhead for the grantor letter, all four lines will
be blank on all screens and copies of the return.

Connecticut

CT-1041 EXT. Overrides for Lines 1, 2, 3, and 5 entered on Extensions > Extensions > Automatic Extension >
Initial Extension will now only pick up the amounts entered with state code CT entered in the State code
field.

Massachusetts

Massachusetts Form 2G, Page 2, will now allow government form overrides.

New York

The paper refund check box on the IT-205, Page 2, will now be marked if the banking information is not in
the return.

New York Electronic Filing

The diagnostics, transmittals, and direct debit/deposit report will now show the extension withdrawal date
entered for the bank debit for the extensions when 4/15, 4/16, or 4/17 is entered.
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Estate & Gift (706/709) Product Updates
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Federal

A worksheet is available detailing the estimated value of Reg. sec. 20.2010-2(a)(7)(ii) assets used to
calculate Form 706, Page 3, Part 5, Line 10.

An option to center lines in footnotes is available on General > Notes > Estate and Gift Footnotes > Indent
Code.

New York
A statement is available detailing intangible property on Form ET-706, Schedule A, Part 2, Line 20.

If there are Reg. sec. 20.2010-2(a)(7)(ii) assets in the return, statements showing adjustments to federal
amounts are added to Form ET-706, Schedule E, Lines 39, 40, 56, and 57.
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